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Checks and Payments Maintenance 
 

Introduction 
 
The Checks and Payments Maintenance page was created to provide you with an area to search out and work 
with your county financial data. There are several common searches which can be done through this page, as 
well as a number of very detailed searches that can be executed. 
 
Along with searches, this page provides you the ability to complete several types of actions on one or many 
checks or payments with a single action. 
 
Lastly, the page provides an export feature, allowing you to export their search results to a .csv file, which can 
then be opened in a spreadsheet format. 
 
This User Guide outlines the common searches and actions that the page offers, and details how to work with 
exported results.  
 

Accessing the Checks and Payments Maintenance Page 
 

From the desktop, go up to Financial > Checks and Payments > Checks and Payments Maintenance. This will 
open the Checks and Payments Maintenance page. 
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Search Criteria Overview 
 

 

1. County: Defaults to your county. For worker without the proper security, the drop-down is disabled. 
 
2. Site/Office: Use this to look specifically search for check or payment data for a certain site. This is 

helpful for larger counties with multiple sites. Note: if selecting by checks and if the check includes 
another site’s payments as well as the selected site, the check would display for both sites. 

 
3. Select By: Defines what is being searched (Checks, Payments, Overpayments, or Payments & 

Overpayments). 
 
4. Check Status: Use this to look specifically for check or payment data based on a certain check status 

(Pending, In Process, Outstanding, etc.). 
 
5. Payee ID: Use this to look specifically for check or payment data for a single Payee. 
 
6. Person ID: Use this to look specifically for check or payment data for a single person (child). 
 
7. Voucher #: Use this to look specifically for check or payment data attached to a certain voucher. 
 
8. Placement Type: Use this to look specifically for check or payment data for a certain placement type 

(Foster Home, Group Home, RCC, etc.). 
 
9. Srvc Cat: Use this to look specifically for check or payment data for a certain Service Category (Foster 

Care, Kinship – Court Ordered, Secure Detention – OHP, etc.). 
 
10. Srvc Type: Requires a selection in the Srvc Cat field. Use this to look specifically for check or payment 

data for a certain Service Type (Shelter Care – Paid, Respite Care – Paid, etc.). 
 
11. Payment Type: Use this to look specifically for check or payment data for certain types of payments 

(Administrative, Costs > Spending Limit, Extraordinary, Maintenance). 
 
12. Payment Status: Requires that the Select By value is Payments, or Overpayments. Use this to filter search 

results by the status of the Payment (Cancelled, Pending Approval, Non-System Disbursed, etc.). 
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13. View Records From and To: Use this to look specifically for check or payment data for a certain date 
range. 

 
14. Sort By: Allows you to define how the data should be initially sorted when returned (defaults to Payee. 

Can be set to Date, Amount Ascending or Descending, etc.). 
 

Common Searches 
 
As mentioned above, the Checks and Payments Maintenance page offers any number of combinations to filter 
and look at your financial data. Listed below are examples of some common searches you may perform on the 
Checks and Payments Maintenance page. Those outlined below are just a few of the many possibilities. This 
being said, it is important to remember that each element selected acts as a filter for the search. So, the more 
search criteria selected the more specific the search will be, and by contrast, the fewer search criteria selected 
will result in a more generalized search. In some instances, the search criteria chosen may be too general, 
resulting in a search that cannot be executed. In this instance, the search will eventually time out. An example 
of a search like this would be a search for all payments for a county with no date parameters. 

 
Pending Checks: 

 

 
 

Pending Release Checks: 
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In Process Checks: 

 

 
 
Payments - for a particular child and date range: 

 

 
 
Overpayments - for a particular provider, dating from a particular date to present date: 
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Payments and Overpayments - for a particular date range, sorted by date: 
 

 
 
All Group Home Payments on a particular voucher run: 

 
 
All Administrative Payments - for a particular provider, for a certain date range: 
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Working with Checks 
 
As mentioned above, the Checks and Payments Maintenance page allows you to complete several types of 
actions on one or even a group of checks or payments. These actions vary depending upon whether you are 
selecting by Checks, Payments, or Overpayments. 
 
The actions that can be completed from this page are: 

• Cancel Selected Checks 

• Cancel and Reschedule Selected Checks 
• Release Selected Checks 
• Set Selected Checks to Pending Release  
• Cancel Selected Payments 

• Link Selected Payments to Pending Checks 
• Cancel Selected Overpayments 

 
This section of the guide will walk through a single scenario. The steps outlined within will be very similar for 
all other possible options. 
 
Canceling a Payment(s): 

 
1. From the Checks and Payments Maintenance page, locate the payment(s) that needs to be cancelled. If 

you need more information before making your selection, click the payment hyperlink to view the 
Payment Request page.  
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2. Select the payment(s) that should be cancelled by selecting the checkbox next to the respective 

payment. 

 

Note: In the example below, we are able to identify more than one payment at a time. 

 

3. From the Options drop-down, select the action of “Cancel Selected Payments” and click Go. This will 

open the Cancel Selected Payments page. 
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4. Once the Go button has been selected a staging page will appear. The staging page gives you one last 
look at the payment data that will be cancelled. You are able to adjust what you are about to do by 
unchecking checkboxes, or you can completely back-out of the process by clicking the Close button. 
Once the Save button is clicked the payments selected will be cancelled. 

 
Note: In the example below, we have chosen to uncheck one of the payments. With this setup we will 

only be cancelling one payment (the highlighted payment). 
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Exporting Results from the Checks and Payments Maintenance Page: 
 
The “Export Results” option from the Checks and Payments Maintenance page allows you to generate ad hoc 
reports of your search results. For example, you can replicate the Pending Checks Report by searching for and 
returning all checks with a “Pending” status. Or, you can replicate the Pre-Audit Report by searching for and 
returning all checks with an “In Process” status. Once the search results have been returned, go to the Options 
drop-down and select “Export Results” and click Go. 
 
In the example below, we are going to generate an export of all checks in an “Outstanding” status for the year.  
 

1. Setup and complete your search. 
 

2. From the Options drop-down, select “Export Results” and click the Go button. 
 

3. A pop-up will appear that asks if you would like to open or save the file.  
a. Clicking on ‘Open’ will simply open the file. You can choose to save the file to your computer 

once open. 
b. Clicking on ‘Save’ will download the file to your computer. You will then be given the options 

to open the file, open the folder the file is saved to, or view a list of recent downloads. 
c. Clicking on the arrow next to ‘Save’ displays the following options: Save, Save as, and Save 

and open. Clicking on ‘Save as’ allows you to select a location to save the file to on your 
computer. 

d. Clicking on ‘Cancel’ will close the message, cancel the export, and returns you to the Checks 
and Payments Maintenance page. 
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4. Using one of the open or save options outlined above, open the export file. 

Note: This guide assumes that the file will be opened and worked with using Microsoft Excel. The rest 
of the guide will walk through some basic setup options that will give greater flexibility when 
working with the export. 
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5. When the file initially opens it will look similar to the screenshot below. 
 

 
 
  



June 2023 13 

6. Put your cursor in the first cell of the spreadsheet and select the Format as Table button. There are several different style setups to 
choose from. Select a format. 
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7. After you select a table format, a pop-up will present illustrating the rows that will be included in your table as well as a checkbox 
indicating that your table has headers. Ensure that all rows are included, and that the checkbox is checked and select the OK button. 
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8. At this point your table will be created. The columns will expand to accommodate the header names. You may notice that the data held 
within exceeds the column width and is cutoff, or if it is a number, it may be displaying as “#####.” 
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9. To resolve the issue described above, simply select the cell just above the first row (this selects the entire worksheet). Then double-
click the line between column A and Column B. This will expand each column in your table to fit the longest content.  
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10.  The end results should look something like this: 
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11.  To hide a column or columns that you do not wish to see, select the column letter, right click, and choose Hide. 
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12. Since the data is in a Table format, we are able to filter the results for specific information by selecting the header drop-down(s) that we 
wish to filter, and choosing the value(s) to filter by. In our example below we are going to look at just our Group Home payment data. 
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13.  The end results should look something like the following: 
 

Note: The results displayed are only our Group Home payments. However, the total that displays is the total for our entire exported 
results. If you wish to see a “Subtotal” based on our filtered results, a new formula must be added to the worksheet. 

 

 
 
 

14.  To add a Subtotal formula to your worksheet, type the following highlighted text, exactly as it is written, in the field directly above the 
Payment Total.  See the following page as an example of where to put the Subtotal.  =SUBTOTAL(9,Table1[Pmnt Total]) 
 

Note: If the above formula does not work then type: =SUBTOTAL(9,S1:S??)  
 

Do not type the “??” in your formula. These are representing an unknown number. Select all your data in column S to get your full 
string. 
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15.  The end results should look something like the following: 
 

 
 

16.  Notice that as the filter changes so does the Subtotal value: 
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Using a Pivot Table to Work with Your Data 

Pivot tables offer another great option for working with and presenting your data in an easy-to-read report.  The next several pages will walk through 
how to create a Pivot Table from your exported results. 
 
It’s easiest if you already have your data in a Table format.  If you’ve followed the steps above (Exporting Results from the Checks and Payments 
Maintenance Page) then you are all set and ready for the next steps. 
 

1. Start by inserting a new Worksheet.  Click just to the right of the current Tab that you are on. 
 

 
 
 
 

  



June 2023 23 

 
2. Right Click on the newly inserted tab and select “Rename”.  Then name the new tab. 
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3. Click on the first cell of your data, choose the Design Tab, and from there select “Summarize with PivotTable”. 
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4. Select Summarize with PivotTable will bring up a Create PivotTable dialog box.  Choose “Select a table or range” your table should 
already populate that box.   
 
For the second Radio Button option choose “Existing Worksheet” and then select the PivotTable Tab that you just previously created.  
You can do this by simply clicking on that new Tab and then clicking on the upper left most cell within that Tab. 
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5. Upon selecting OK on the dialog box, the PivotTable will display 
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6. Now you can start creating your PivotTable.  Drag items from the “fields to add to report” to your “Row Labels” box and “Values” box. 
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7. Your Row Labels represent the specific “unique” elements that you look at your data across.   In our example we are going to look at our 
payment data across Payee and Child.  In other words, we want to create a display of all payments (within our data) broken down by 
Payee and Child. 
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8. Now you can start setting up the specific values that you want to look at.  In this instance we are going to look at Cost “buckets”. 
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9. Your desired data values might look something like the following: 
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10. The default display is a “compact” view, not necessarily the easiest to look at.  So, let’s change how things look.  Click anywhere on your 

report and then click on the “Design” tab.  Then choose “Report Layout” and select “Show in Tabular Form”. 
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11. Notice that the children are no longer nested under the Payee and that they now have their own column.  Also notice that we added 
Payment Begin and End Dates to our Row Labels. 
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12. The problem with adding Payment Start and End is that the Pivot Table wants to “Subtotal” these.  If we were to select one or the other, it 

will not do this.  If you select both as is in the screenshot above, you will notice the Total value below each.  If we want to see both 
values, we can simply add a column in our data worksheet that combines the two.  Here’s a sample of how to do that.  Note:  The 
formula can be typed in the first cell and then simply fill down the rest of your data. 
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13. If we add our new column to our Row Labels, we will have something that looks like the following: 
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14. Let’s take a little more specific look at things.  Select the filter option for Payee Name(ID) and we will choose Granny Smith. 
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15. You will notice that there were two sets of payment data.  One for Humming Bird, and one for Kid Bird.  The Combined Date represents 
each month’s payments.  At the bottom of child’s payments is a Subtotal for each of our Cost “Buckets”, and at the very bottom is a 
Grand Total for Granny Smith. 
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16. Remember that the PivotTable looks for “unique” values for items entered in the Row Labels.  This can change the way your data 
presents as is illustrated in the screenshot below.  Here we’ve removed Combined Date and are now looking at things across Days Paid.  
In this instance it has summed all the Cost “buckets” based on Days Paid.  For Humming Bird there was one month where it only paid for 
2 days.  There were two (2) months where it paid for 30 days, and there were four (4) months where it paid for 31 days.  In the Basic 
column it summed the basic amounts paid for the 30-day months, which totaled $800.00.  It summed the basic amounts paid for the 31-
day months, which totaled $1576.13, etc.  Not quite the display we were looking for here. 
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17. Once you have your PivotTable setup you can further refine the way it looks with some simple formatting.  Select the Design Tab on the 
PivotTable Tools and then choose a PivotTable Style.  If you select the down arrow in the bottom right of that group box it will open up to 
display a number or other options. 
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18. Choose an option that fits your liking or define a new PivotTable Style. 
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19. After formatting your report might look something like the following: 
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20. You can further refine your report by adding spaces, Subtotals, and Grand Totals. 
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21. Your final results might look something like the following: 
 

 


